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Helping you, the author, have the 
best experience with your current 
project and all future endeavors. 

- From the Staff at

Congratulations! You have finished your manuscript and have 
decided to self-publish your book. We have taken our 30+ years of expertise 
and developed an easy to use guide to help take you through the exciting  
world of self-publishing. 

This guide is a reliable, practical, and straightforward reference guide for 
you. Through common language (or defined if we found it questionable) 
and a conversational tone, this guide provides you with vital information 
about self-publishing and the best practices and tips you can use for any 
style of books.

In addition to understanding the terms and responsibilities 
you have as a self-publisher, you will learn the value of 
knowing terminology, tips and information valuable to 
every self-publisher. This will give you the confidence 
to bring your book to life and give you the maximum 
opportunity for success in your new adventure. 

All of the tasks involved in self-publishing from writing 
the manuscript to formatting and finally selling your book are detailed in 
this guide.

By no means are we able to guarantee your success, but if you follow 
our tricks of the trade, we sincerely hope they bring you all the success 
in the world. If you’re ready, let’s get started. 

HOW TO USE THIS BOOK

PRO TIP
- WHAT IS A PRO TIP?

Throughout this book you’ll see TIP boxes like this one. 
In them you’ll find the most common questions, concerns 
and fun facts we’ve encountered over the years. Be sure 
you take note of them!
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PRO TIP
FRONT MATTER
- WHAT IS A COPYRIGHT PAGE?

A copyright page is extremely important for all self-
publishing authors. This lets everyone know that the 
contents of your book is your intellectual property - and 
yours alone. You want to be sure to include your name, 
address, date and copyright symbol at the very least. 

If you’ve had your cover art designed, photographed, 
or illustrated. Be sure to give credit to your artist; they 
deserve the same copyright acknowledgment as you do.

HINT: ALT 0169 will give you the copyright symbol © ! 



WE DEDICATE THIS BOOK TO ALL AUTHORS

“Whatever you may have heard, self-publishing is not 
a short cut to anything. Except maybe insanity. Self-
publishing, like every other kind of publishing, is hard 
work. You don’t wake up one morning good at it. You 
have to work for that.” 

- Zoe Winters 
Smart Self-Publishing: Becoming an Indie Author

PRO TIP
- DEDICATION PAGE

The dedication page is for those who deserve a special 
thanks, acknowledgment, or other form of appreciation... 
This would also be a great spot for a quote, photograph or 
illustration.
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Blitzprint Inc. is not your average printer! Over our 30+ years, 
we have made it our mission to marry the finest contemporary printing and 
book-manufacturing technologies with the best in traditional, personal 
service. We know our clients need the speed, efficiency and high quality of 
state-of-the-art digital-imaging systems. They also benefit from direct and 
easy access to skilled, helpful and enthusiastic people. We know printing. 
We know publishing. And we’re delighted to share what we know.

Located in the most advanced colour-digital facility of its kind in Western 
Canada, Blitzprint leverages decades of experience 
to deliver the highest standard of colour reproduction. 
We were the first company in Canada to offer digital 
short-run book printing. Since then we’ve produced 
more than 6,000 printed titles, including best-selling, 
self-published books. 

At Blitzprint, you’ll find great people who get a kick out 
of having helped thousands of new authors realize their 
self-publishing dreams. Our experience has shown us 
that 99 percent of self-publishing authors simply need 
a printer who is dedicated to books. So here’s the deal: 
You retain full rights to—and control over—your work, and we’ll supply the 
right combination of services, expert support and ongoing guidance to help 
you succeed in the highly competitive book marketplace. 

Together, we’ll produce a great book—well-written, well-made.

PROLOGUE

Here’s the Deal: You retain full 
rights to—and control over—
your work, and we’ll supply the 
right combination of services, 
expert support and ongoing 
guidance to help you succeed. 
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YOUR FIRST STEPS

THE MANUSCRIPT

Once your manuscript has been written, editing is the 
next step. The world’s finest authors rely on skilled 
editors, because the best writing always benefits 
from a professional editor’s fresh set of eyes. We can 
recommend editing professionals and publishing 
proofreaders who have the insight, command of language 
and literary skills to help you impress book reviewers 
and the media. 

A content editor will dig into your book and help you 
strengthen its structure and development of themes 
and character.

A copy editor will make changes to your sentences, 
focusing primarily on grammar, word usage, syntax 
and punctuation. 

A proof reader will double check the text for typographical, 
spelling, and formatting errors. 

You can find an editor through Editors Canada, the 
Writers’ Guild of Alberta, or ask us for a recommendation.

Editors Canada will put you in touch with a variety of 
professionals to help you on your journey including 
proofreaders, copy editors, translators, and indexers.

Reedsy.com is a online service that brings a community 
of freelance professionals such as editors, designers, 
marketers and ghostwriters who have the experience 
to craft your book.

The best writing always 
benefits from a professional 
editor’s fresh set of eyes.  

EDITORS CANADA 
Phone: 1 (416) 975-1379 
Toll Free: 1 (866) 226 3348 
Fax: 1 (416) 975-1637 (Attn: WGA) 
E-mail: info@editors.ca 
www.editors.ca

REEDSY
www.reedsy.com
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WHAT YOUR PRINTING QUOTE NEEDS

When you are looking for a pricing quote you will need to know what the finished size of your 
book will be, the page count of the manuscript and quantity of books you wish to order. 

Because your book is now edited you will have a much better idea of this. If you aren’t sure what 
size book to go with, visit your local bookstore and look at books in the same genre as yours. 
What sizes are most common? What size feels right to you? 

Still have questions? Refer to the checklist below to help you get the most accurate 
quote possible!

  SIZE

4”x7”   5”x8”  5.5”x8.5”  6”x9”

8”x8”   8”x10”  8.5”x11” 

  LAYOUT ORIENTATION

Portrait  Landscape Square

  PAGE COUNT - only the inside pages of your 

book

# of B/W pages:_____________________

# of Colour pages:____________________

 
All our covers are printed in colour on the front 
outside cover and the back outside cover

There is an option to print the inside cover as 
well, however there are some limitations and 
we will discuss this with you if you request 2 
sided covers.

  BIND TYPE

Perfect Bound   Plasticoil  Wirecoil

Saddle Stitch   Lithowrap (Hardcover) 

 Hardcover with Dust Jacket 

  ADDITONAL SERVICES

Cover Design   Inside Page Formatting

Hard Copy Proof   Image Scanning

Typesetting  Photo Editing
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DESIGN AND FORMATTING

The old saying of “don’t judge a book by its cover” unfortunately doesn’t 
hold true. Many people do select a book based on its appearance. You 
worked hard on your book, and now is the time to make sure your book 
will appeal to your audience.

Now, think back to the last book you read. 
What did the page look like: typeface, margins, 
headers, footers, line space kerning... WHAT?!  
Okay, okay, we’ll get to that later (See Glossary). 

What we’re trying to say is that good design is 
seamless, it lets the viewer enjoy your book 
without a struggle. 

So sit back and enjoy the ride of learning how to turn your manuscript 
into a masterpiece!  

Good design is seamless,  
it lets the viewer enjoy your 
book without a struggle.  

PRO TIP
DESIGN AND FORMATTING

Your design should speak to the content or subject matter 
of your book. Go to the bookstore, local library, or your 
own bookshelves and see what others are doing. This will 
give you a great starting point to creating a unique layout 
for your new book.
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2.  Chapter Start

3. Lead Paragraph

10. Quote

9. Margin

4. Drop Caps

5. Body Content

6. Ruling Line

7. Page Number 8. Footer

1. Header

THE BASICS: PAGE OVERVIEW
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THE BASICS: PAGE OVERVIEW – DEFINED

   1. THE HEADER

This modern book design omits any information 
that usually appears. Although unusual, the 
empty header provides a good use of white 
space and enhances the overall book design. 
Headers often list the title of the book on the 
right hand page, and the author’s name on the 
left. It is also an option to have the name of 
each chapter or section appear in the header.

   2. THE CHAPTER START

This one has two decorative elements: a green 
puzzle piece, and a small capitalized sans 
serif. This is one of the many design options 
that can be used for chapter headings! It’s 
up to you, and your personal style. Note 
that the content starts down a few inches 
from the top of the page, and the book 
title has been omitted from the bottom.  
 

   3. LEAD PARAGRAPH

The lead paragraph is usually not indented. In 
this example, we also see a dropped capital 
letter (drop cap) that complements the chapter 
title font.

    4. THE DROP CAP

Is a large initial letter that drops below the 
first line of a paragraph, usually used at the 
beginning of a section or chapter of a book. In 
this reference we used a display script typeface 
for a decorative and elegant introduction to 
the paragraph.

   5. BODY CONTENT

References the text that comprises the story 
of the book. This is the section where it is crit-
ical to use an easy-to-read typeface (page 18),  
appropriate line length (page 21), and easy to 
view leading (page 22).

   6. RULING LINE

Straight line used as a border or divider line 
in a document. A ruling line may be employed 
to define a box, panel, or other component of 
a document, as well as to separate the entire 
document from its surroundings. A decorative 
ruling line may be used to enhance the design 
of the document. In this case, a ruling line has 
been used to separate the footer from the 
main content to let the reader know ‘this is 
the end of the page’.
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   7. PAGE NUMBER

Usually found in the header or footer, the 
page number identifies the page of the book 
the reader is on and indicates the sequence 
for the table of contents and easy reference. 
Page numbers can be used to add flair to the 
book without compromising the integrity of 
the main content. 

   8. FOOTER

A footer complements the design of the book 
and can have the same content you would 
see in the header as long as it didn’t appear in 
the header. It is important to keep this area as 
uncluttered as possible for the best reading 
experience. This design uses a ruling line to 
divide the content, a decorative swirl, the page 
number, plus the book title. 

   9. MARGIN

This book measures 8.5”x11” in print, and has 
outside margins of 0.83”, top and bottom of 
0.83” inch, and an inside margin of 0.83”.  This 
is the space around the book that gives the 
book room to breathe, and makes it print-ready. 
If the margins are incorrect you will run into 
issues with text being cut off, or going into the 
binding. It’s important to consider this when 
formatting your book as a printed book vastly 
differs from an on screen proof. 

   10. QUOTE

To repeat or copy out (a group of words from 
a text or speech), typically with an indication 
that one is not the original author or speaker.  
Quotations can be used in your book as a 
great way to break up heavy content. This 
allows the reader a chance to have a visual 
break, as well as grabbing attention if it’s just 
being scanned through by a potential buyer. 

PRO TIP
DESIGN AND FORMATTING

Simple is always in style but if you are feeling 
adventurous, or want something with a little more flair, 
there are tons of tools and designs to make your book 
shine. Why not? You’ve already dedicated countless hours 
writing your manuscript now show your readers your 
passion and excitement! 
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Times New Roman 
The quick brown 
fox jumped over 
the lazy dog.

Georgia 
The quick brown 
fox jumped over 
the lazy dog.

Garamond 
The quick brown 
fox jumped over 
the lazy dog.

Minion Pro 
The quick brown 
fox jumped over 
the lazy dog.

Book Antiqua  
The quick 
brown fox 
jumped over the 
lazy dog.

Aa Aa

Serif

Aa Aa Aa
SERIF: 11/16

THE BASICS: TYPOGRAPHY

 THE SERIF

Serif fonts are easier to read in printed 
works. This is because the serif makes 
the individual letters more distinctive and 
easier for our brains to recognize quickly. 
Without the serif, the brain has to spend 
longer identifying the letter because the 
shape is less distinctive.

A question we are asked almost daily here at 
Blitzprint and this is the answer, although you 
can use anything sitting in your font library,  
there are some considerations you should take 
into account before choosing “Eccentric” as 
your body copy. This is the most important 
decision you will make in regards to your book, 
but don’t panic - we’re here to help. The best 
practice is to keep decorative or quirky fonts 
to a minimum. It’ll make when you do use 
them more impactful! Play with titles and page 
numbers in an irregular style. 

Next is the body copy. If you have large 
amounts of text, or are looking for a traditional 
approach, any of the serifs below will suit your 
needs if you’re looking for a more modern or 
contemporary novel any of the sans serifs 
on page 19 can give you that appearance. 
Be sure to note that the typeface you choose 
has all the variations you need: bold, semi bold, 
italic, light, heavy, condensed. 

   WHAT FONT SHOULD I USE?
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Arial 
The quick brown 
fox jumped over 
the lazy dog.

Futura 
The quick brown 
fox jumped over 
the lazy dog.

Gill Sans 
The quick brown 
fox jumped over 
the lazy dog.

Century Gothic 
The quick 
brown fox 
jumped over 
the lazy dog.

Calibri 
The quick brown 
fox jumped over 
the lazy dog.

Aa

Sans Serif

Aa Aa Aa Aa
SANS SERIF: 11/16

PRO TIP
CHOOSING A TYPEFACE

When choosing your typeface be sure to take into 
consideration what your content is about. Using a 
traditional serif typeface may not be the best choice for 
say a zombie apocalypse novel. Unless, of course, Jane 
Eyre is the one being chased.  

 THE SANS SERIF

Sans Serif fonts are used both on 
the web or for large headings. Sans 
Serif fonts are also good for small 
text, emphasis, and when children are 
learning to read due to the simplicity of 
the shape. 
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Garamond 9pt - Very small for reading, long line lengths.

  Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once or twice she had peeped into 
the book her sister was reading, but it had no pictures or conversations in it, ‘and what is the use of a book,’ thought Alice ‘without pictures or 
conversation?’ 
   So she was considering in her own mind (as well as she could, for the hot day made her feel very sleepy and stupid), whether the pleasure of 
making a daisy-chain would be worth the trouble of getting up and picking the daisies, when suddenly a White Rabbit with pink eyes ran close 
by her. 

Garamond 11pt - Standard font size, line lengths are not too long.

  Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once or twice 
she had peeped into the book her sister was reading, but it had no pictures or conversations in it, ‘and what is the use of 
a book,’ thought Alice ‘without pictures or conversation?’ 
   So she was considering in her own mind (as well as she could, for the hot day made her feel very sleepy and stupid), 
whether the pleasure of making a daisy-chain would be worth the trouble of getting up and picking the daisies, when

Garamond 12pt - Larger than standard - visually beneficial for older readers.

  Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once 
or twice she had peeped into the book her sister was reading, but it had no pictures or conversations in it, ‘and 
what is the use of a book,’ thought Alice ‘without pictures or conversation?’ 
   So she was considering in her own mind (as well as she could, for the hot day made her feel very sleepy and

Garamond 16pt - Very Large Text - good for the visually impaired

  Alice was beginning to get very tired of sitting by her sister on the bank, and of 
having nothing to do: once or twice she had peeped into the book her sister was 
reading, but it had no pictures or conversations in it, ‘and what is the use of a 

Garamond 10pt - Small for reading, fits a lot of text on the page

  Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once or twice she had 
peeped into the book her sister was reading, but it had no pictures or conversations in it, ‘and what is the use of a book,’ thought 
Alice ‘without pictures or conversation?’ 
   So she was considering in her own mind (as well as she could, for the hot day made her feel very sleepy and stupid), whether the 
pleasure of making a daisy-chain would be worth the trouble of getting up and picking the daisies, when suddenly a White Rabbit

An 11 or 12 point font is usually a good size for reading. But every font is different and different 
fonts at the same point size may be much larger or smaller than another. Older readers usually 
prefer a slightly larger font size, but really large sizes should be used only if readability for the 
visually impaired is a concern, or for beginning readers.

THE BASICS: FONT SIZE
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6.75” Line Length - Garamond 11pt

  Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once or twice 
she had peeped into the book her sister was reading, but it had no pictures or conversations in it, ‘and what is the use of 
a book,’ thought Alice ‘without pictures or conversation?’ 
   So she was considering in her own mind (as well as she could, for the hot day made her feel very sleepy and stupid), 
whether the pleasure of making a daisy-chain would be worth the trouble of getting up and picking the daisies, when

5.5” Line Length - Garamond 11pt

  Alice was beginning to get very tired of sitting by her sister on the bank, and of having 
nothing to do: once or twice she had peeped into the book her sister was reading, but it had no 
pictures or conversations in it, ‘and what is the use of a book,’ thought Alice ‘without pictures 
or conversation?’ 
   So she was considering in her own mind (as well as she could, for the hot day made her feel

4.5” Line Length - Garamond 11pt

  Alice was beginning to get very tired of sitting by her sister on the bank, 
and of having nothing to do: once or twice she had peeped into the book her 
sister was reading, but it had no pictures or conversations in it, ‘and what is the 
use of a book,’ thought Alice ‘without pictures or conversation?’ 
   So she was considering in her own mind (as well as she could, for the hot

3.5” Line Length - Garamond 11pt

  Alice was beginning to get very tired of sitting by 
her sister on the bank, and of having nothing to do: 
once or twice she had peeped into the book her sister 
was reading, but it had no pictures or conversations 
in it, ‘and what is the use of a book,’ thought Alice 
‘without pictures or conversation?’

5” Line Length - Garamond 11pt

  Alice was beginning to get very tired of sitting by her sister on the bank, and of 
having nothing to do: once or twice she had peeped into the book her sister was 
reading, but it had no pictures or conversations in it, ‘and what is the use of a book,’ 
thought Alice ‘without pictures or conversation?’ 
   So she was considering in her own mind (as well as she could, for the hot day made

1.5” Line Length - 
Garamond 11pt

  Alice was beginning 
to get very tired of sitting 
by her sister on the bank, 
and of having nothing

1.5” Line Length - Garamond 11pt

  Alice was beginning to get very tired 
of sitting by her sister on the bank, and of 
having nothing to do: once or twice she 
had peeped into the book her sister was 
reading, but it had no pictures or

1” Line Length - 
Garamond 11pt

  Alice was 
beginning to get very 
tired of sitting by her 
sister on

2” Line Length - Garamond 11pt

  Alice was beginning to get very 
tired of sitting by her sister on the 
bank, and of having nothing to 
do: once or twice she had peeped 
into the book her sister was

When deciding on the size of your book, line length should be a consideration. You will 
want to aim to have approximately 15 words per line. Long lines cause eye strain, where 
short lines will annoy your reader. Remember that the size of your type also dictates the 
line size.  Here we see examples using 11pt Garamond we think the best situation in this 
instance is 4.5”, but what do you prefer?

THE BASICS: LINE LENGTH
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THE BASICS: LINE SPACING (LEADING)

Garamond 11pt   
1 - This is a large chunk of text creating a thick text box which may be intimidating to the reader.

   Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once or twice 
she had peeped into the book her sister was reading, but it had no pictures or conversations in it, ‘and what is the use of 
a book,’ thought Alice ‘without pictures or conversation?’ 
   So she was considering in her own mind (as well as she could, for the hot day made her feel very sleepy and stupid), 
whether the pleasure of making a daisy-chain would be worth the trouble of getting up and picking the daisies, when 
suddenly a White Rabbit with pink eyes ran close by her.

Garamond 11pt  
1.15 - Lots of breathing space for the text to be legible and enjoyable to the reader

   Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once or twice 
she had peeped into the book her sister was reading, but it had no pictures or conversations in it, ‘and what is the use of 
a book,’ thought Alice ‘without pictures or conversation?’ 
   So she was considering in her own mind (as well as she could, for the hot day made her feel very sleepy and stupid),

Garamond 11pt  
1.5 - More breathing space for the reader but still enjoyable - will increase page count.

  Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once or twice 

she had peeped into the book her sister was reading, but it had no pictures or conversations in it, ‘and what is the use of 

a book,’ thought Alice ‘without pictures or conversation?’ 

   So she was considering in her own mind (as well as she could, for the hot day made her feel very sleepy and stupid),

Garamond 11pt  
2 - Too much space between lines; the reader may become annoyed and disregard your book.

	 Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once or 

twice she had peeped into the book her sister was reading, but it had no pictures or conversations in it, ‘and what is the 

use of a book,’ thought Alice ‘without pictures or conversation?’

Leading is the distance between the lines of type. This term came from the days of 
typesetting when thin strips of lead were inserted between the lines of type to increase 
distance. Please note that larger typefaces and serifs will need more space to breathe.   
Here we see leading examples with Garamond 11pt, with various degrees of leading.
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THE BASICS: CHOOSE YOUR BINDING

THE BASICS: CHOOSING YOUR PAPER

White Offset Paper: This is the most popular paper stock and can be used for both black  
text and colour printing. It is available in a 60lb weight for books under 300 pages and  
50lb* weight for books above 300 pages. 

Narural/Cream  Paper: Cream-coloured paper stock is a nice choice for text-based printing.  
It is not recommended for colour images as the cream-coloured paper can skew the colour 
slightly.  Available in a 60lb weight for a page count under 300, and 50lb* weight for books 
with page counts above 300.

Enviro-Friendly Paper: Available in white and natural/cream colours and is recommended to be used  
for text-based books. 

*The option of lighter weights for higher page counts reduces the thickness of your book.

1.	 Perfect Binding: To bind sheets together at 
the spine and held to the cover by an adhesive or  
glue. Also called soft bind or soft cover.

2.	 Lithowrap (Hardcover): Hardcover book with 
image wrapped directly around the cover. 

3.	 Hardcover with Dust Jacket: Hardcover book 
with cloth cover; The jacket is wrapped around  
a hardcover book. 

4.	 Plastic Coil: Using a piece of plastic coils to bind 
multiple sheets of paper together. Useful for cook 
books, agendas, or manuals.

5.	 Wire Coil: Using a series of wire coils to bind 
multiple sheets of paper together. Useful for  
cook books, agendas, or manuals.

6.	 Saddle Stitch: Four page signatures on one  
sheet bound together in middle with staples. 

2.

3. 4.

5. 6.

1.
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   PRINT-READY FILE  
A print-ready file is a PDF that is set up for 
printing. We print exactly what you send, so 
the file must have correct bleed allowances 
(.125”), image resolution (300ppi) and colour 
space (CMYK). PDFs for book files should be 
sent as single page spreads with the press 
quality feature on Adobe Reader.

   BLEED ALLOWANCE 0.125”

Bleed allowance refers to the part on each 
side of the page that the image extends off 
the sheet. Typically artwork and background 
colours will extend into this area to ensure the 
page will look exactly as intended by the author. 
If there is no bleed, the edge of the paper will 
have a thin white line as we cannot guarantee 
100% accuracy during the bindery process.

   SPINE WIDTH  
To figure out the spine width you must know  
the finished page count of your book, and 
paper chosen. Use our Spine Calculator on 
our website for easy reference. 

   IMAGE MODE: CMYK

For best colour reproduction, images should be 
converted into CMYK or Greyscale. Blitzprint 
would be happy to convert your images for you 
at a nominal fee. Images that are left in RGB can 
be printed, but there is no guarantee on colour 
reproduction, or quality of the end product. 
 
 

   BEST RESOLUTION: 300 DPI

When inserting images into your book, be 
sure to have your images set to at least 300 
dpi (dots per inch) at the size intended for the 
image on the page. If the resolution is lower 
than 300dpi, your image will appear grainy. 
It is also important to note that any images 
with fine lines, or text need to be at 600 dpi 
for maximum image quality and effectiveness.

   MINIMUM MARGINS: 0.5”  
To ensure your book prints and binds as intended, 
we require a minimum margin of 0.5” with a 
gutter of 0.25”.  

   COVER PDF

Covers should be set up to print as a single 
PDF that contains front, back, and spine in 
one piece, with a .125” bleed, and saved with 
crop marks. If you’re having trouble, Blitzprint 
would be glad to design a professional cover 
for you. We can also advise you on how to 
build your own.

   BARCODES

Not all books need barcodes. However, if you 
are planning on distributing your book in retail 
settings or librairies, you must have a bar code. 
Blitzprint can make a barcode  for you using 
the ISBN number you applied for. Ensure you 
leave room for your barcode at the bottom left 
or right side of your back cover measuring 1” 
by 1.75”, at least 0.5” away from the cut edge 
and spine.

THE BASICS: FORMATTING FOR PRINT
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Setting your margins allows for the words 
on the page to breathe. It also ensures no 
words will end up in the binding or cut off in 
the printing process. 

•  Go to Page Layout > Page Setup > 
Margins tab

•  Go to the Pages section and from the 
pull-down menu, select Mirror margins

•  Minimum margins for Top, Bottom is 0.6”, 
Inside and Outside minimum is 0.5”. 
These are the minimums, more space 
especially towards the spine is always 
better!

•  Gutter is 0.25”

•  In the Orientation section, select Portrait

•  In the Preview section, select Apply to: 
Whole Document

•  Click OK.

Margin Tab

Preview Tab

OK - confirms choices

TUTORIALS

SETTING YOUR MARGINS

At Blitzprint we understand that formatting can be hard. So we have created 
a few simple tutorials to get you started on your way to success! But, if you’re 
having trouble, contact one of our book specialists and we’ll create a solution 
that works specifically for you.
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Preview Tab

If your manuscript is already written, go to File in Microsoft Word and select Save As to 
make a copy of your manuscript. This will ensure you have an untouched back-up copy of 
your manuscript to reference and copy and paste from. 

•  Go to Page Layout menu > Page Setup, then Paper tab

•  From the Paper size pull-down, select Custom Size

•  Insert the Width and Height; we will typically quote on a 6” x 9” – you will be safe to 
design your book at this size; adjustments can be made later. 

•  Ignore the Paper source part and leave as the default values.

•  In the Preview section, select Apply to: Whole Document

•  Click OK.

Page Layout Menu

Page Setup

Paper Tab

How “Wide”

OK - Confirms Choices

How “Tall”

SETTING YOUR PAGE SIZE
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•  Select the paragraphs for which you want to change the line spacing.

•  On the Home tab, in the Layout group, click into the Paragraph Menu.

•  Click Indents and Spacing, and then select the options that you want under Spacing.

•  Review your changes, adjust if necessary. Refer to page 22 for help or suggestions on 
spacing.

Paragraph Menu

Line Spacing

Indents and Spacing Menu

SETTING LINE SPACING

OK - Confirms Choices
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Setting up basic chapter headings is easy with Word. Microsoft Word has enabled 
predefined themes for you to use in the design of your book. 

•  Go to the Pages Layout Menu and insert Section breaks between each chapter; This 
creates your chapter “sections”.

•  Select your pre-determined theme from the style menu. You can select your fonts and 
colours from this menu as well.

•  Go to each chapter, select your heading text and click one of the heading quick styles. 
Typically “Heading 1”. Continue this for each chapter.

•  If you have subtitles, select “Subtitle” from the quick style menu.

Quick Style Menu

Heading 1

Subtitle or Heading 2

SETTING YOUR CHAPTERS AND HEADINGS

Page Layout Menu Theme Menu

Breaks Menu
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The easiest way to create a Table of Contents is to use the built-in heading styles. 

•  Ensure you are happy with the formatting of your book. This should be the final stage of 
interior formatting.

•  Click where you want to insert the Table of Contents, usually at the beginning of a 
document.

•  On the References tab, in the Table of Contents group, click Table of Contents, and then 
click the table of contents style that you want.

•  Review the styling of your table of contents and make any adjustments if needed.

References Tab

Table of Contents Menu

CREATING YOUR TABLE OF CONTENTS

Table of Contents Style

Your New Table of Contents
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Blitzprint uses a PDF (portable document format) workflow. That means we convert all files to 
PDF before sending them to press. If you’ve formatted your document on your own and are 
satisfied you have print-ready files that will require no further work prior to printing, you can 
create the PDF versions yourself.

•  Click the File tab.

•  Click Save As.

•  In the File Name box, enter a name for the file, if you haven’t already.

•  In the Save as type list, click PDF (*.pdf).

•  If the document requires high print quality, click Standard (publishing online and printing).

•  Click Options to set the page to be printed, to choose whether markup should be 
printed, and to select output options. Click OK when finished.

•  Click Save.

SAVING A PRINT-READY FILE
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To create your cover you must have a front, a back and a spine. To get your spine size visit 
our [spine calcuator] at:

www.https://blitzprint.com/authors-toolkit/

Our example is 6” x 9” with a 0.625” spine. Created using Adobe InDesign.

•  Create your document as a single page document. Your width will be calculated by 
adding your front, back and spine widths together. Your height will be the measurement 
of how tall your book is.

•  Add in a 0.125” bleed around your document

•  Place a guide at your first mark (size of back page), place a guide at second mark (size of 
back page and spine).

•  Insert images and text to create your desired cover.

•  Save as a High Quality PDF with Bleeds.

Spine

Bleed

Margin

CREATING YOUR COVER FILE
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Self-Publishing

Every BOOK has a beginning.

A sample brought to you by Blitzprint Inc.

Front CoverBack Cover

Bleed

ISBN

Trim Size

Spine

Shown above: Full colour cover art exported as a High Quality PDF ready for printing. Correct margins and placement has been 

established for printing a soft cover 6” x 9” book.

PRO TIP
COVER DESIGN

Although Microsoft Word is a great word processor, 
it is not the best program in which to build a print-
ready cover. Using a typical layout program such as 
QuarkXpress, Adobe InDesign, Adobe lllustrator, 
Affinity Designer or Affinity Publisher will create a 
professional-looking cover to showcase your book.
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REGISTERING & ISBN

REGISTRATION & BARCODE

Your book will need an ISBN (International 
Standard Book Number) and barcode. The ISBN 
is a worldwide identification system used to 
register and track your book. The ISBN is used 
for book ordering, cataloguing, inter-library loan, 
and stock control procedures.

Contact the Canadian ISBN Agency at Library 
and Archives Canada to get your free ISBN.

CANADIAN ISBN AGENCY
Library and Archives Canada 
395 Wellington Street 
Ottawa, ON K1A 0N4 
Phone: (819) 994 6872 
Toll Free: 1 (866) 578-7777 
Fax: 819-934-7535 
E-mail: BAC.ISBN.LAC@canada.ca 
http://www.bac-lac.gc.ca/eng/services/isbn-
canada/Pages/isbn-canada.aspx

COPYRIGHT

Copyright is the exclusive right to copy a creative 
work or allow someone else to do so. In Canada, 
a book is automatically protected by copyright 
as soon as it is written. You do not have to 
register your copyright to have protection in 
Canada. However, registering your copyright 
through the National Copyright Office can be 
useful in the event of a legal dispute.

CANADIAN INTELLECTUAL PROPERTY OFFICE
Industry Canada Mail 
Place du Portage 1 
50 Victoria Street, Rm C-114  
Gatineau, QC K1A 0C9 
Phone: 1 (866) 997-1936 
Fax: 1 (819) 953-2476  (General inquires) 
E-mail:  ic.contact-contact.ic@canada.ca 
www.cipo.ic.gc.ca

DOCUMENT YOUR ISBN NUMBER

   -  -        -  - 
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THE PRINTING PROCESS

THE PROOF

After the book and cover have been properly 
designed and laid out, the next step is to proof 
the book.

We offer the option of having a PDF proof to 
review or you can also request a printed proof 
of your book. This is the time to make final 
revisions and corrections. Plan for a week or 
two of time for proofing and revisions. 

THE PRESS RUN

Once your proof is approved, we will schedule 
the printing and binding of your book’s press 
run. If you have a specific date that you need 
the books for, please let us know and we’ll 
work to meet that deadline. 

WHAT HAPPENS DURING THE PRESS RUN

YOUR ORDER IS 
PLACED WITH US

PRINT READY FILES 
SUBMITTED

FILES SENT TO  
PRINT

PROOF REVIEWED BY 
CLIENT

BOOK BLOCKS & 
COVERS CUT DOWN

BOOK PUT THROUGH 
THE BINDING MACHINE

BOXING & SHIPPING

START

ARE FILES 
CORRECT 

FOR PRINT?

RECREATE NEW FILES 
FROM SUGGESTIONS

no yes
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   BIND

A method that is used to create a book from 
individual printed pages. Methods include but 
are not limited to; gluing (perfect binding), sewn 
(smyth-sewing), stapled (saddle stitch), or coil 
(plastic or metal spirals). 

   BLEED  
Images that are on the page that extend over the 
edge of the sheet.

   BODY TEXT  
Body text is the copy that is present throughout 
the inside of the book 

   PROMOTIONAL BLURB  
A promotional description about the book or author, 
as found on jackets of books or on a website.

   CMYK  
CMYK is a colour model in which all colours are 
described as a mixture of these four process colours. 
CMYK is the standard colour model used in offset 
and digital printing for full-colour documents. 
Because such printing uses inks of these four 
basic colours, it is often called four-colour printing

   COATED PAPER  
Paper that has a coating - usually of clay - creating 
a smooth and often reflective surface. Most paper 
mills produce coated paper in gloss, silk and matte.

 
 

   COVER  
Generally a heavy paper stock that protects the 
contents of a book. Parts of a cover include; Front, 
Back, Spine, Inside Front, Inside Back.

   CROP MARKS

Marks placed at the corners of a page or document 
to indicate where the page is to be trimmed.

   CROPPING  
The act of cutting off the undesired portion of a 
printed piece, photograph or book.

   DPI

DPI (dots per square inch) is a resolution measurement 
that defines how many dots of ink are placed on the 
page when the image is printed. Found in images 
that are scanned or pictures taken by a camera

   END SHEET  
The sheet that attaches the inside pages of a 
hardcover book to the cover.

   FACING PAGES

In a double sided document, the two pages that 
appear together when a book is opened. 
 

   FINISH SIZE

The final size of the product after it has been 
completed. Also called trim size.

GLOSSARY
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   FORMAT

Size, style, shape, layout or organization of a page 
layout or printed book.

  GLOSS  
A type of finish on various materials that cause light 
to reflect off the item (e.g. paper, ink, laminates, 
UV coating, varnishes).

   GUTTER

The inside margins on a book used towards the 
back or binding.

   HEADER

Content at the top of the page; usually containing 
the author’s name, or title of the book.

   ISBN

International Standard Book Number. A number 
assigned to a published work and found on the 
copyright page and forms the barcode.

   JUSTIFICATION

The process of setting lines of type to span the full 
width of the paragraph from left to right. Opposed 
to ragged right - where the  lines of type do not 
line up on the right side of the paragraph.

   JUSTIFIED  
Type that has been formatted to align on both the 
right and left side of the paper. 

   KERNING

Spacing between the individual characters to 
create an aesthetic harmony within a printed piece.

   LAMINATE

A thin, transparent plastic coating applied to the 
cover of a book which provides protection against 
heavy use. Found in both gloss and matte finishes 

   LANDSCAPE

The orientation of a page or book that the width 
is greater than the height.

   LEADING

Term that refers to the spaces between the lines 
of text. Usually referred to as line spacing.

   LOW RESOLUTION

Image that is displayed on a computer display 
or printed piece that has a low dpi (usually under 
200 dpi).

   MANUSCRIPT  
An author’s unformatted and original form of their 
work - often a digital file. Used for submission  
in publication.

   MARGIN  
White space that surrounds the copy on the page.

   MATTE FINISH  
Flat (not glossy) finish on a printed piece or document. 

   MOCK UP  
A rough version of a book, with pasted in images 
and text. Used for direction, pacing, and instruction 
for complicated pieces.

   PAGE

One side of a leaf, or sheet of paper in a printed 
publication.
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   PAGE COUNT

Total number of pages that a publication or book 
will have.

   PERFECT BIND

To bind sheets together at the spine and held to 
the cover by an adhesive or glue. Also called soft 
bind or soft cover.

   PORTRAIT

The orientation of a page or book that the height 
is greater than the width.

   PROOF  
An early copy of to-be-reproduced material produced 
as a means of checking for typos, positional errors, 
layout problems and colour check.

   RGB

Abbreviation for red, green, blue - the colours 
of light. Most digital images are in this format for 
display on computer screens. 

   SADDLE STITCH

Binding style where sheets of paper have been 
printed on both sides and folded in half to create 
four pages. These are then bound and stapled in 
the centre.

   SPINE

Back or binding edge of a publication or book.

   SPIRAL BIND

Binding using a spiral of continuous wire or 
plastic looped through drilled holes. This is also 
referred to as coil or wire-o.

   TYPE FAMILY  
A group of typefaces created with a common 
design. Each member will have varying degrees 
of differences such as italic, bold, condensed.

   TYPOGRAPHY

The process of setting print quality type. Involves 
placement, positioning, and specification of type 
to ensure maximum legibility and aesthetic appeal.

   VECTOR GRAPHIC  
Image or graphic created by a digital program not 
based on pixels like a photograph. The size and 
detail remains consistent regardless of the size.
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NOTES:



Blitzprint inc. | 37

NOTES:
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NOTES:
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